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Topic: Gadgets 
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President Piper’s Ponderings…. 
 
Our November General Meeting will be Carol 
Picard telling us about all her gadgets. She has 
at least 25 different items to show us, so I am 
sure you will hear about something that 
interests you. Her talk looks like a good chance 
to make out your Christmas list. Think about 
bringing your own gadgets to this meeting, 
especially any of the “wearables” or fitness ones 
that are so popular now. I have a gadget you 
won’t want to miss. 
 
December will be our usual holiday meeting. 
The Club will provide pizza and pop, you bring a 
dish to pass. We will not be discussing any 
specific topic. 
 
As your Board looks to 2016, we see January 
being a series of short subjects. February is 
looking like a discussion on backup and syncing 
of files, what options are available, and what are 
the differences between the two. 
 
It is that time to think about Club officers for the 
coming year. I will put forth a tentative slate of 
officers at our November meeting; we will hold a 

formal vote in December. 
Contact me if you would like 
to expand your horizons by 
serving on our Board.  
 
As we approach another 
Thanksgiving season, I must 
give thanks for having our 
Computer Club to challenge my interests and 
my brain, for having an active and 
knowledgeable Board to guide the Club, and for 
having an interested membership that is willing 
to share their experiences.  
 
See you Wednesday, November 18 at our 
General Meeting 
 
(The above comments are the opinion of the author 
and do not necessarily reflect the views of the 
Midland Computer Club.) 
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2015 BOARD MEMBERS 
 

MCC  OFFICERS 
President         Larry Piper   larryp56@chartermi.net 
Treasurer         Jan Ensing  btiger6@juno.com 

Membership   Gary Ensing  btiger6@gmail.com 

Editor & 
  Webmaster  

 
AT-LARGE BOARD MEMBER 
Joe Lykowski joseph@lykowski.com 

 
PROGRAM COORDINATORS 
Howard Lewis             lewis3ha@chartermi.net  

Bill Tower             tower.w@gmail.com 

Please let Howard or Bill know of topics you 
would like covered at future meetings.  

 
PUBLICITY 
Al Adams                           aladams12@yahoo.com  

    Membership  Enrollment  Form        
 
       NAME  _______________________________________           PHONE  __________________ 
 
       ADDRESS  ___________________________________________________   
 
       CITY    __________________              ZIP  _______________       
 
        EMAIL ADDRESS     ___________________________________________ 
 
       Membership dues   FAMILY ($20)      STUDENT ($15)     New Member ____    Renewal   ____ 
 
                     Please fill out the above form and mail it along with payment of check or money order to : 
 
           MIDLAND COMPUTER CLUB         Attn: Memb ership Chairman 
              1816 Bauss Ct 
             Midland, MI  48642-4023   
                                                                      You may also pay for membership at a regular club meeting 

Board Meeting 
First Thursday of the month 

No Board meeting in December 

7:00 PM 
Chapel Lane Presbyterian Church,  

5501 Jefferson Ave., Midland MI 

Useful, useless and strange (in no 

particular order) Web Sites: 
 
http://tinyurl.com/qa9hwyz 
YouTube hosts a bunch of “how-to” videos on 
Windows 10. 
 
http://www.dailygood.org/ 
I image that we all get tired of the bad news that 
comes our way every day. This site will give you 
some good news for a change. 
 
http://www.myrateplan.com/ 
If you happen to be in the market to replace your 
current cell phone plan, this site will allow you to 
compare various cellphones and plans so you can 
find the best one for you. 
 
http://www.befrugal.com/ 
Save money by using one of these coupons on 
restaurants, shopping and tours at many of your 
favorite stores. 
 
http://tinyurl.com/ohavc62 
Many of the major financial sites over free 
investment advice for potential investors. Vanguard 
has some excellent ideas on how you might want to 
get started. 
 
http://tinyurl.com/q2oladh 
An elephant didn’t like how this sprinkler head was 
working so she proceeds to “adjust” it herself. She 
then enjoys playing in it. 

Carol Picard   webbyte@yahoo.com 
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Tips, Tricks & Techniques (submitted by Carol Picard) 

 
Windows 10 activation explained 
Windows 10 activation works differently than previous versions of Windows. These articles try to explain 
how activation works and what happens if you upgrade your computer hardware or reinstall Windows 10. 
 
http://www.zdnet.com/article/two-new-windows-10-resources-microsofts-official-activation-and-servicing-
guidance/ 
 
http://windows.microsoft.com/en-us/windows-10/activation-in-windows-10# 
 
 
Windows 10 - Task Bar - show search icon, show sear ch bar or hide 
By default in the Windows 10 task bar, a search bar is displayed for searching for items on the device or 
the web. If the bar takes up too much space, you can change it to a magnifying glass icon, or hide it.  
 
Right click anywhere on the task bar and move cursor over the word Search 
In pop-out window, click to select either Hidden or Show search icon 
 
 
Windows 10 Updates - share update files with computers on the Internet? 
There is a setting in Windows Updates that allows sending parts of updates to devices on your network 
and also to devices on the Internet. Sending updates to devices on your network may mean they only 
need to be downloaded once from Microsoft rather than downloading to each of your computers. 
However, if you are concerned about using your data/bandwidth to send updates to devices on the 
Internet, follow these instructions to change the setting: 
 
Windows Update Settings (logged on to an Administrator account) 

Settings > Update & security > Windows Update > Advanced options > Choose how updates are 
delivered 

Updates from more than one place 
Turn off, or, leave on and change to only get updates from “PCs on my local network” 

 
http://www.howtogeek.com/224981/how-to-stop-windows-10-from-uploading-updates-to-other-pcs-over-
the-internet/ 
 
 
Automatic driver install in Windows 10 
In previous versions of Windows, driver updates were optional and you had to decide whether or not to  
install. In Windows 10, driver updates are automatic. These articles provide information on driver updates 
and how to turn off automatic driver installation, if you chose to do so: 
 
http://www.howtogeek.com/233115/the-only-way-to-safely-update-your-hardware-drivers-on-windows/ 
 
http://winsupersite.com/windows-10/stop-automatic-driver-updates-windows-10 
 
 
What’s new in Windows 10 fall update 
 
http://www.howtogeek.com/232176/whats-new-in-windows-10s-first-big-update-the-windows-10-fall-
update/ 

 



Bits and Bytes November 2015 Page 4 

 

ARTICLE INDEX 
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The Adobe Photoshop Lightroom 5 Book for Digital Ph otographers -- Page 6 
 Scott Kelby, Editor/Publisher of Photoshop User magazine 
Scam I Am -- Page  8 
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Get Around Quickly in Word Documents -- Page 14 
 Nancy DeMarte, 1st Vice President, Sarasota Technology User Group, FL 
 
 
Articles in this Newsletter have been obtained from APCUG with the authors’ permission for publication 

by APCUG member groups. The Midland Computer Club has not verified the information contained in 

the articles nor tested procedures or hardware/software. Articles do not necessarily reflect the views of 

the Midland Computer Club. 

 
 

 
OneNote serves as a computerized memory 
Review of OneNote meeting presentation 
By John Weigle, Editor, Channel Islands PCUG, CA 
June 2015 issue, The Outer Edge    www.cipcug.org    Jweigle (at) vcnet.com 
  
OneNote is the perfect place to keep all that information you want to remember and find easily when you 
need it, Toby Scott said at the May meeting. “It still is the greatest piece of software ever written,” Scott 
said, even though at first it doesn’t seem like much. 
 
Because it’s “ideal for storing random data,” and because we all have a lot of that, “the longer you use it, 
the more valuable they (the OneNote entries) are.” 
 
“It’s a hugely useful program, but it’s only useful if you use it,” Scott added.  
 
OneNote started as a paid part of Microsoft Office, but it is now a free tool available for Windows, Macs, 
iOS (iPhone and iPad) and Android. It can be downloaded at https://www.onenote.com. The link is at the 
top right corner of the page. 
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OneNote is designed to resemble school notebooks on your computer and in the cloud. It’s set up in three 
organizational trees, documents, sections and pages, and that layout makes it easy to store material by 
topics. But its search engine is so good that users can put material anywhere in the program, and it will be 
easy to find, he said.   
 
Scott recommends keeping the notebooks in Microsoft’s OneDrive so they’ll be available on any device 
wherever you are. Among other things, he keeps articles and websites that he finds on how to fix unusual 
computer problems. 
 
But that’s just one possibility, he said. When he was planning a trip to Utah, he stored Web pages and 
other information about the state, including places he might want to visit. When you copy text or pictures 
from a website and paste it into OneNote, it automatically adds a link back to the source. The link is 
clickable, so it’s easy to return to original information sources.  
 
Users can add material to OneNote with copy and paste, drag and drop and “send to.” Tools for Firefox 
and Chrome browsers let users save full Web pages to OneNote.  
 
Users can insert Excel spreadsheets and PowerPoint presentations or links to them in the program.   
  
OneNote has optical character recognition abilities so its search function can find text in pictures and 
graphics. Scott demonstrated that by taking a screen shot of a DOS screen, putting it in OneNote and 
searching for a word that was in the graphic. The word was highlighted each time it appeared.   
 
Skype calls can also be recorded and saved in OneNote, as can emails. Templates for other Office 
programs work in OneNote. Notebooks, sections and pages can be password-protected and shared with 
other people.  
 
Asked how OneNote and Evernote compare, Scott said that Evernote was developed as a free alternative 
to OneNote, which cost about $150 when it was first released. Scott said it’s best to use one or the other, 
but not both, because they can’t open each other’s files.  
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Although Scott knew about OneNote, he didn’t start using it until a speaker at an Intel conference used it 
to find an answer to an attendee’s question. The speaker didn’t recall the answer but had it stored in 
OneNote and found it easily. When most of those attending asked about the program he used to find the 
answer, the speaker quickly wrapped up his Intel presentation and demonstrated OneNote, calling it “the 
only way to keep track of all this stuff.”  
 
Asked how OneNote compares to Dropbox, Scott said they’re entirely different. 
 
OneNote is a program, while Dropbox is a cloud storage system like Microsoft’s OneDrive and Google’s 
Google drive. Don’t confuse the storage media with the program that stores the data, he advised. 
 
Another person asked about calendars in One Note. OneNote has a weak calendar function, Scott said, 
but you can’t store a calendar in it that provides repeating events and similar tools. There are third-party 
templates that work quite well. Many are for special situations, so you need to figure out what you need. 
Calendars are persnickety, he added. 
 
For things like calendars, mail and contacts, “you pretty much have to settle on one platform, he said, and 
he prefers Outlook, also part of Microsoft Office.  
 
People can use the cloud to synchronize or back up various devices, but they don’t need to store 
everything in several cloud storage sites. Because of size limits, however, some people might find it 
easier to store photos in one location, music and video in another and other data in a third. That all 
depends on how much data is involved, he explained.  
 
If a device that has OneDrive access — such as a laptop — is lost or stolen, Scott said, he can go to 
OneDrive and block its access to the device. At the OneDrive website login screen, highlight the device, 
and click on Remove PC. Users should also enable two-factor identification so that any new device that 
logs into your OneDrive has to be authenticated by entering a code that Microsoft sends to your primary 
device, he added. In this way, a hacker who discovers your username and password still cannot get to 
your data. 
 
An audience member asked if it’s possible to stop Android devices from backing up photos before she 
gets a chance to delete ones she doesn’t want. The answer is to go to the Photo App in settings and 
change the auto backup settings. 
 
An audience member noted that a spreadsheet that was cut and pasted into OneNote loses its 
functionality. Another member of the audience asked if there’s a good tutorial for OneNote. Scott said 
there are many videos on YouTube and written material on other sites, but they’re not needed. The best 
way to learn OneNote is to start using it. 
 

 
 
The Adobe Photoshop Lightroom 5 Book for Digital Ph otographers 
By Scott Kelby, Editor/Publisher of Photoshop User magazine, President of the National Assn. of Photoshop 
Professionals (NAPP), co-host of the live weekly photography talk show "The Grid," and co-host of "Photoshop User 
TV" 

 
Review by Mark Mattson, Editor, Computer Users of Erie, PA 
www.cuerie.com    cuerie01 (at) roadrunner dot com 
 
Lightroom has become, in the few short year since introduction, one of the most-used digital imaging 
applications on the market. 
 
Not only is it an organization tool and image catalog, it allows you to make highly sophisticated edits and 
adjustments to your images outside of traditional image editors, such as Photoshop. 
 



Bits and Bytes November 2015 Page 7 

 

Although a relatively easy program to navigate and operate, there is much power hidden under the hood, 
some of which will take you a while to figure out on your own. Thus the reason for this book. 
 
First off, this is a BIG book. I was a bit surprised when I looked at the page count box in Acrobat, and saw 
that it was well over 1200 pages long. But when I checked the Peachpit website, I found that the print 
version is only 552 pages. A bit more reasonable, but still… Of course there IS a lot to cover, so every 
page is packed with text and illustrations designed to teach you what you need to know. 
 
The volume is divided into 15 chapters, each exploring, in detail, a module of Lightroom. It flows naturally 
as you would use the program, starting with Importing Photos, moving to the Library module, then 
spending the bulk of the book on Developing and adjusting your images. 
 
The sub-topics in each chapter are designed to be learned in a specified number of steps for each 
concept, so as not to overload you with everything at once. That way, you can spend as much time as you 
need to learn a certain concept properly, before moving on to the next step in that process. 
 
As mentioned, every module in Lightroom is covered in this book, with the exception of one: the Web 
module. 
 
According to Kelby, Adobe has not updated or changed anything in the Web module since around 
Lightroom v2. As such, he felt it would be a disservice to make readers wade through information they 
may already know from previous versions of this book. However, he has the omitted chapter available on 
his website for you to download, if you wish to have it handy. 
 
With many DSLRs now equipped with video functionality, there is a section on working with video in 
Lightroom. It can guide you to using the features to work with your video files. 
 
As a special bonus, chapter 15 is devoted entirely to giving you a complete look at author Kelby’s 
workflow of images he shot, from start to finish. This allows the reader a chance to see all the concepts 
put together in one place, and to follow along as the editing progresses. 
 
There are also downloadable images available on Kelby’s website to allow you to follow along with him as 
he does his adjustments and edits, learning along with him, just as if you were in his class. A nice bonus, 
at no extra charge! 
 
Scott Kelby’s Adobe Photoshop Lightroom 5 Book for Digital photographers is available direct from the 
publisher, Peachpit for a list price of $49.99. However, you get a 35% discount if your group is a member 
of Peachpit’s user group program. 
 
It is also available online from Amazon.com (see the page at http://www.amazon.com/Photoshop-
Lightroom-Digital-Photographers-Voices/dp/0321934318/ref=tmm_pap_title_0  .   
< http://amzn.to/16m4Mjh> 
The price on Amazon is $30.86. 
 
If you’re a photographer needing a way to organize and edit your images without investing in the full 
Photoshop package, Lightroom provides an attractive alternative to get you going. And this book is your 
guide through that world. 
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Scam I Am 
by Greg Skalka, President, Under the Computer Hood User Group, CA 
April 2015 issue, Drive Light    www.uchug.org     president (at) uchug.org 
 
Scam I Am 
I don’t like things to slow me down 
The web is made to click around 
Passwords are a royal pain 
There’s no room for them inside my brain 
 
My inbox may be filled with spam 
But I’m not worried about a scam 
Google’s tracking helps me shop 
My Facebook postings never stop 
 
Hackers will not target me 
There are bigger fish in the world-wide sea 
My check has bounced - there’s no money left 
Oh no!  I’m a victim of identity theft! 
 
Scams, cons, theft and deceit have been around forever. Just as technology has helped us increase our 
productivity, it has helped the crooks become more efficient as well. The old scams and trickery have 
been made easier to execute, while new forms of theft have been developed. 
 
The authenticity of bank robber Willie Sutton’s quote about why he robbed banks, “Because that’s where 
the money is”, may be in question, but robbers today still go where there are things of value. Now their 
targets are subscriber personal data at Anthem Blue Cross, credit card information at Target and account 
information from phishing attempts on individuals through email. 
 
With so many institutions, from banks, retailers, insurance companies, medical providers and even the 
government holding sensitive information about us and apparently not protecting it all that well, we are all 
at high risk of institutional data theft, though there is not much we can do to prevent it. For most of us, 
hiding out in the woods with no legal residence, credit cards or medical coverage is not an option. I have 
Anthem Blue Cross health insurance, so since their announcement of the loss of subscriber data through 
a cyber attack, all I can do is take advantage of their offer of free credit monitoring and identity theft 
protection, and watch my accounts and credit reports carefully. While we can’t do much about the 
institutional data hacks, we can do a better job of protecting ourselves from those threats that target us 
individually. 
 
There is a strong correlation between crime rates and the proximity to a freeway onramp; access to a 
highway facilitates finding victims and provides criminals a quick and easy getaway. The connection to the 
Information Superhighway we get through our computers, tablets and smart phones works in the same 
way, bringing the potential for crime closer to us. Now financial misfortune can be as close as our inboxes 
or browsers. 
 
We have all received those ridiculous emails reported to be from Nigerian customs officials, foreign 
attorneys and even the head of the FBI, asking for help or offering huge sums of money for us to claim. It 
is hard to believe anyone falls for these scams anymore, yet I still continue to receive the emails. I’ve also 
received many emails that appear to be from banks, credit card companies and online services, but are 
really phishing attempts. These are generated by criminals intent on tricking me into providing them with 
my sensitive information. A lot of them are easy to spot; they may be from institutions I don’t have 
accounts with, or may have misspellings or other flaws that are a tip-off that they are fakes. I have 
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received some very convincing phishing emails, however. Either by random chance or because the 
scammers knew I had an account there, I’ve received emails that appeared legitimate and pertinent to my 
situation, but after close examination and research, turned out to be fakes intended to scam me. 
 
With income tax filing season in full swing, the media is presently full of warnings about email and phone 
scams related to the IRS. We hear about all these scams and hacks; hopefully we take these warnings 
seriously and don’t disregard them as things that only happen to others. I’d heard about phone scams 
where callers try to convince you that a loved one is in trouble and you must send money to help them, 
but I never considered them a serious threat until someone tried to scam my mother. 
 
A few weeks ago, my mom called our home and asked if our daughter was all right. She then told us the 
story of the scam call she had just received. Fortunately, she was suspicious and did not get taken. It is 
not clear if she was targeted specifically by scammers with knowledge of our family situation, or if it was 
just a random call. 
 
When my mom answered the scam call, a young female voice said “Hi Grandma.” Since she has only one 
granddaughter, my mom replied “Hi Alli”, so it is not clear the caller knew my twenty-four-year-old 
daughter’s name beforehand. 
 
The caller initially engaged briefly in some small talk, like how have you been and such, but then, either 
having some knowledge or taking a chance, asked if Grandpa was there. The scam would have been 
exposed at that point had my father been deceased, but fortunately he was there. 
 
The caller then said “Grandma, I’m in trouble, but you have to promise not to tell anyone else in the family 
about this. Can you do that, Grandma?” 
 
My mom was getting a little suspicious, but agreed. 
 
The caller went on.  “Grandma, a good friend of mine died suddenly and I’m in Virginia for the funeral.  
Because she was Jewish, they had to bury her right away, so I had to travel on short notice. After the 
funeral, some other friends and I stopped at a restaurant for a drink before returning to our hotels. I only 
had one drink, but because I was also taking antibiotics for bronchitis, I hit a street light and knocked it 
over on the way back.” 
 
The addition of bronchitis to the scam narrative is interesting as it generates sympathy for the caller (she 
is not just a drunk) and could explain why she perhaps did not sound quite like my daughter. This scam 
would understandably work best on grandparents that don’t often get calls from their granddaughters. I’m 
certain my wife and I would have been able to recognize our daughter’s voice had we been called. 
 
The caller continued.  “Grandma, I’m at the police station here. They said they would not charge me with 
anything if I could pay for the damaged street light, but I don’t have the money. A lawyer here is willing to 
pay for it on my behalf if you can send him the money. Here is a policeman.” 
 
A male voice came on the line.  “Hello, this is Officer Raleigh. Your granddaughter needs you to send 
$2300 to cover the damage to the street light, and then we can release her with no charges. Can you do 
that?” Officer Raleigh then provided detailed instructions to my mom on sending the money. She was to 
take $2300 in cash, with two IDs, to a Walmart and send it via Western Union MoneyGram to Ronald 
Pearlman in Bristol, Virginia. When Officer Raleigh asked if she understood all of this, my mom replied 
that she didn’t think all this sounded right. 
 
Officer Raleigh put the phone down for a minute, as if he was not sure what to say. When he came back 
to the call, he began repeating the payment instructions again. When my mom again said she didn’t think 
this sounded right, Officer Raleigh hung up. The scam was thwarted. 
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I told my mom’s story to a coworker a few days later and she said a similar thing had happened to her 
relatives in Mexico, except that it was kidnappers calling to say they had their daughter. Her relatives 
unfortunately paid $1500 before finding out their daughter had been safe at a friend’s house all along. 
 
With all our personal information entrusted to companies and the Internet, hackers and crooks can have a 
much easier job deceiving us. To avoid being taken advantage of by these thieves, we all must 
unfortunately be more suspicious and skeptical. Just because you’re paranoid doesn’t mean they are not 
out to scam you. 
 

 
 
The 2014 Tech Review 
By Diane Fahlbusch, President / Editor, ICON PCUG, New York 
December issue, The ICONPCUG Graphic    Editor (at) iconpcug.org 
 
Each year brings new technology, whether they are “toys” or “tools”, as reincarnations or completely new 
inventions. 
 
Operating Systems:   This year saw no dramatic shifts in the market share dispersement of devices and 
operating systems.  The triumvirate still holds:  Apple  dominates smart phones, Linux  dominates tablets 
and Microsoft  still holds its domination over laptops and desktop computers.  However, traditional 
Windows users are NOT migrating to the new Surface Tablet, nor has Windows 8.1 been well received.  
As a matter of fact approximately half of the Windows users are still using Windows XP.  And many are 
considering some form of Linux instead of sticking with a Microsoft OS.  Perhaps Microsoft is trying to 
distance itself from Windows 8 by calling its latest OS in the works Windows 10. 
 
Browsers:   The king of browsers, Firefox , dramatically dropped to third place behind Google Chrome .  
This is probably due in part to Chrome’s ability to run on more OS’s than any other browser (Windows 
XP, 7, 8, 8.1, Mac and all Linux distros including Android) and in large part to the lack of support for 
Windows XP, which ended very shortly after the OS support ended.  As a quick aside, if you are one of 
the many XP users you need to use a browser that is continuing to support your OS.  So IE8 (the highest 
version that will run) is also not a viable option as support ended long before support for XP ended.  Try 
Opera , Maxthon  or Google Chrome .  Also check that your security software is also being supported. 
 
Smart Technology:   Smart watches  have been a big flop, primarily because the screens are too small.  
Additionally, only the Martian Notifier allows you to customize the alert (email vs. text) as it comes in.  But 
Apple is still looking into it.   
 
One of the more useful new Smart toys is the GOJI Smart Lock .  Once installed, this device uses 
Bluetooth connectivity to send a signal via a free app to remotely lock doors, cabinets … and 
automatically open the lock when your Smartphone is near.  (You can also set it up to greet you by 
name!)  It also has a built-in camera that will take pictures of everyone who approaches your door and 
transmit those images to your Smartphone via you home network’s Wi-Fi.  Should you lose your 
Smartphone, call GOJI’s 24 hour call center (or visit their website), cancel that phone and transfer access 
to another phone, effective immediately. 
 
There are many free apps that will help you get in better shape, and the new Voyce Band helps you track 
your dog’s activities.  This dog collar tracks everything your pet does during the day including meal 
content and pertinent health information.  Of course you can also look into the Scanadu  for yourself.  This 
small device can track temperature and certain blood levels.  Additionally, there is the Kolibree Smart 
Toothbrush which tracks brushing information (length of time, habits…), but also teaches how to brush 
properly.  This information can be shared with others and posted to social media.  Hmm, I'd think about 
that last one! 
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Medical Technology:   Digital Dental X-Rays are recent advance.  They use radiography, where a small 
sensor is used instead of photographic film.  Dentists get the results immediately and can view them on as 
large a screen as they like, as well as dropping the patient’s exposure to radiation by 90%.  But at $5,995 
for an IRIS Intraoral Digital Camera, don’t expect most dentists to dash to make the switch. 
 
An amazing advance is a new twist on Electroknives, which have been around since the 1920s. Going by 
various names, the Onkoknife , iKnife , or Intelligent Scalpel, developed by Zoltan Takats, Ph.D.  (a 
Hungarian research chemist associated with Semmelweis University in Budapest) burns through tissue 
with an electrical charge, just like its predecessors.  However the iKnife extracts information from the 
vapor given off to detect cancer cells.  It is being used very successfully, but is limited to cancer detection 
in a surgical environment. 
 
Affordable 3D printing has given rise to 3d Bio printers .  Initiated by a team of doctors, researchers, 
technicians, and students at the Cardiovascular Innovation Institute (CII) on Muhammad Ali Boulevard in 
Louisville, Kentucky, they are striving to print a human heart.  The object is to use undifferentiated stem 
cells and use cells from the individual to receive the replacement tissue/ organ.  At present, the equipment 
available is too slow and the printhead runs on a three-axis robot that doesn't handle curves very well.  
However, Invetech  partnered with Organovo  (located in California) to create the world’s first commercial 
3D Bio printer.  Organovo is dedicated to continuing to develop this technology. 
 
But the piece of medical technology that wowed everyone at a recent tech show was the Brainwriter .  
Developed by NotImpossible Labs , it is a next-generation device that reads basic brain waves (EEG) to 
engage and disengage a computer mouse, allowing the user to draw using only their thoughts, or “blink-to
-think”.  It allows fully paralyzed individuals to continue to write and draw by tracking eye movements.  
This approximately $400 make-it-yourself open source device is made from a headband, Olimex sensors, 
a shielding board, an OpenBCI board (which is an EEG device) and an eye-tracking device (i.e. SYMeyes, 
Tobii or EyeTribe).  This was the next step up from the Eyewriter  – another make-it-yourself device that 
uses low-cost eye-tracking glasses ($50-$100) and open-source software to allow people suffering from 
any kind of neuromuscular syndrome to write and draw by tracking their eye movement and translating it 
to lines on a screen. 
 
Entertainment:   TVs have some interesting innovations with UHD and curved screens.  Some of the 
curved screen TVs allow can be returned to a flat screen with a push of a button.  But at $17,000 for an 
LG 84inch UHD, don’t expect to see one in every home. 
 
Disney’s  quest to be the best has caused them to develop amazing new software, Hyperion , for their 
newest movie, BIG Hero 6, which allows light to be used in a completely new way for animation.  After 200 
million computing hours to create, it has the ability to deal with acutely complex calculations in order to 
account for how light bounces from its source then across other objects before reaching the camera.  It 
also required the use of a 55,000-core supercomputer to complete its task. 
 

 
 

The Tip Corner – January 2015 
By Bill Sheff, Lehigh Valley Computer Group, Pennsylvania 
January 2015 issue, The LVCG Journal    www.lvcg.org    nsheff (at) aol.com 
 
Here it is, the start of another year.  Happy New Year Everyone.   
 
Looking back on what has transpired in the computer field takes my breath away. Take memory for 
example.  In the 30 plus years of personal computing, memory has gone from 32 Mbs to double digit Gbs 
and machines, even laptops, now come with quad core CPUs.  Storage space has become cheaper and 
cheaper. I was shopping the other day and saw a Seagate external hard drive of four TB and it cost just a 
few bucks more than the one TB I purchased a few months ago.  Price? $137!  WOW!  Registries have 
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increased, and even the tablets have increased in RAM and storage. On the programing side we now 
have machines that have sophisticated Text to Speech and Speech to Text. I use a text-to-speech 
program to read my spreadsheet numbers so I can double check them. I remember sitting with another 
person as we read to each other to double check. We can now do it by ourselves. Video editing using free 
NLE (non-linear editing) programs is a snap, and they even break the film down into scenes based on 
time or change of scene so you can drag and drop in a second. If you are an old 8mm camera guy you 
must remember cutting, numbering and hanging up scenes so you could arrange and edit your home 
movies. The list goes on and on.  But with all these great improvements we still can use some help on 
how to use them. so...On To The Tips.  
 
Firefox 4.0 Quick Find 
Long for a keyword to help you search an article? You can hit Ctrl>F and type in your query, but in Firefox 
4 just hit, the / key on your keyboard (located just to the left of the Shift key) and start typing. 
 
Windows Copy as Path 
When you right-click on a file or a folder you bring up an action menu with basic choices, like “Open” or 
“Copy.” If you hold down the Shift key when you right click in Windows the usual menu that pops up will 
now include an option called “Copy as Path.” This will copy the entire path of the file or folder to your 
clipboard, and allows you to paste it wherever you want. This is useful once you’ve located a file in 
Explorer and you want to upload it to a Web site. So, instead of taking the time to browse for the file on 
the site, you can just copy and paste its path directly. 
 
Print part of an email or other text 
While this is really a simple copy and paste exercise some people seem to have a problem with the 
concept, so here are some pointers and an explanation. 

When you highlight and right-click on what you would like to copy the highlighted portion goes into the 
Window's clipboard.  

You do not see it, but it is there. 
You can open another email or a blank word document or Notepad.  
You can then click Paste, and the text appears.  
If you copied some pictures along with the text that you do not want, instead of just right-clicking, go to 

Edit>Paste Special and click on unformatted text.   
None of the graphics will be included.  
You can then send out the email or save the text document as usual. 

 
What's In A Word? 
To keep from overusing a word when writing we go to the shelf and bring down a thesaurus.  Well forget 
Roget, here are some thesaurus sites you might be interested in. 
 
The Cook’s Thesaurus 
If you need a food substitute this is the site to go to. But it does more. It also has information, 
pronunciations, pictures and more!. 
 
On the main page, there is a featured section where you’ll find the Ingredient of the Month. You will learn 
how to cook it, what to serve with it, and even what to look for when buying it,  
 
Further down you will find a listing of categories. Everything is there from fruits to vegetables, flavorings, 
baking supplies, fats and oils and even equipment. Each category breaks down into a list of items that fit 
the category you can explore further.  Along with the food substitutes you get an education about the 
ingredients and equipment you cook with. Find it at:  http://www.foodsubs.com/ 
 
Open Office and Libre Office 
The document writer in these two free suites have a way to find substitute words. Right-click on the word 
to be changed. Towards the bottom of the list that opens you will see Synonyms. You will see a list of 
other words that can be used. Choose one and it will replace the one you started with. 
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If none of those words suit you, proceed to the Thesaurus. Like everything else there is more than one 
way to get there. While in Synonyms select Thesaurus at the bottom of the synonyms list. Or you could 
also go to the Tools menu, Language sub-menu, Thesaurus choice. But the fastest was is just highlight 
the word and use Ctrl>F7. Ctrl>F7 also works in MS Word. For those using Word 2007 and later the 
thesaurus is found on the Review ribbon.  OK, and now for you texters. Being limited to 140 characters 
certainly puts a damper on the creative juices, but have no fear, just take a trip to IronicSans.com/thsrs/. 
You type in a long word click the search button and it gives you a shorter synonym. To find out more 
about the Thsrs, check out the “Why a shorter thesaurus?” link under the search field. It will tell you all 
about the site and why it was made. 
 
So now you should never be at a loss for words. 
 
I Love My XP What Can I Do? 
 XP is user-friendly, and a lot has changed in the 12 years since XP was launched. But now that Microsoft 
has ending support, XP is highly vulnerable to external threats such as viruses and malware. 
 
While we know that updating to Vista, Win7 and Win8 are valid options there is one more option that 
should be considered - Ubuntu. 
 
Ubuntu is a Linux operating system and is considered a superior system to XP. 
 
You may not be familiar with Linux. It’s an operating system for computers, like Windows. And while Linux 
started out with text only operations it is now a fully operating GUI system. While I am a Windows User 
and have slowly migrated up to Win8, for those that have continued to use XP and like it, you might want 
to consider the switch. Especially for those older machines with minimum CPU and storage. 
 
The switch from Windows XP to Linux Ubuntu may not prove to be the horrific experience that you might 
imagine. And while the family of Linux users pales beside Windows, some consider it a much better 
system. It will give you much more than you get from Windows XP or even from Windows 7 or 8. 
 
Here are some of the pluses with Linux Ubuntu you might want to consider. 
 
Security:   Presently, Ubuntu claims to be a virus free OS, but just like Apple, once there is a community 
of users the hackers will arrive.  But since XP is no longer supported the risks are greater that malicious 
software is out there.   
 
Speed:   Older computers with minimum resources have a tendency to clog when using windows. Ubuntu 
runs for a long time without any lag since it uses a lesser amount of resources and boosts performance in 
older machines. 
 
Cost:   Hello! Ubuntu is free. And no product key is needed. 
 
Space:  Ubuntu occupies much less hard drive space than XP. Other versions of Ubuntu such as Xbuntu, 
take up even less space and provide almost the same functionality. 
 
Drivers:   There’s is no headache in installing drivers for audio, video and graphics from external sources 
in Ubuntu. The OS automatically detects your hardware and installs the latest drivers. Even if you have 
lost your drivers, you can still acquire sound and video drivers automatically while using Ubuntu. 
 
Software:  Ubuntu has lots of useful software absolutely free with no catches or hidden charges. Software 
like Firefox, Chrome, Libre Office, Open Office and many more can be found at Ubuntu Software center. 
Another special software, Wine, helps you run most of your Windows based software without any trouble 
at all. 
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Customization:  Ubuntu users have full customization options. You have the choice to change your 
desktop colors, task bar sizes and make custom side bars. 
 
So if you want to hang on to your old machine, Ubuntu offers a unique opportunity. So think about it, and 
perhaps give it a try. Actually, you can even have both systems on your machine while you take the time 
to so if it appeals to you. 
 

 
 
Get Around Quickly in Word Documents 
By Nancy DeMarte, 1st Vice President, Sarasota Technology User Group, FL 
March 2015 issue, Sarasota Technology Monitor    www.thestug.org    ndemarte (at) Verizon.net 
  
Do you write multipage documents or ones based on an outline? Do you save them from other sources? If 
so, you should get familiar with a helpful feature that was introduced with Office 2010 and refined in Office 
2013 - the Navigation Pane. This tool helps you move quickly from one part of a document to another, 
reorganize sections without cutting and pasting, and find nearly anything in the document. 
 

 
This sort of navigation is not new. Windows Vista, 7, and 8 
users are familiar with the Navigation pane that sits on the left 
edge of the Explorer window (shown), giving easy access to 
anywhere on the computer with one click – Favorites, 
Desktop, Libraries, etc. This concept is now part of many 
Office applications. In Word 2013, it offers all kinds of 
assistance with multipage documents. 
 
 

 
 
To view this feature in Word 2010, either click the View tab on the ribbon and 
check Navigation Pane or press Ctrl + F on the keyboard. In Word 2013, you can 
also click the page count on the left end of the status bar along the bottom of the 
window. The Navigation Pane appears in the area left of the document window, 
displaying a Search box above three tabs.  
 
 
 
Let’s explore the tabs: 
 
The Headings  tab (Figure 2) lets you move around quickly in a document which contains headings. To 
use the time-saving Headings feature, you must have applied one of the Word Heading styles to the 
headings in the document. The Styles Gallery is found on Word’s Home tab. To apply a style, an easy 
way is to use Format Painter (Home tab – Clipboard group). Select the first heading in the document and 
click the Heading 1 style. Then select that heading again, double click Format Painter, and click each 
succeeding heading. They will become the Heading 1 style. 
 
 

Figure 1  Naviga�on Pane in Windows 7 
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If you wish, you can also create a new style for headings and save it to 
the gallery. To do so, click the down arrow with a line over it in the 
bottom right corner of the Styles gallery and choose “Create a Style.” In 
the dialog box, name your style and choose a font, size, color, or other 
options. Click Save and your new heading style will appear in the 
Styles gallery. 
 
 
 
 
 

 
Clicking the Headings  tab displays a list of only the document’s 
headings, as in Figure 4, giving you an outline of the document’s 
structure. Clicking a heading opens that section in the document 
window. You can reorganize sections by dragging a heading to a 
new spot; all its related text moves with it. Other actions become 
available if you right click a heading, as shown.   You can add a 
section in the middle of the document, for example, by choosing 
“New Heading Before (or After)” or turn a heading into a sub-
heading by clicking “Demote.” “Promote” reverses the move. The 
“Collapse all” command is used to hide sub-headings so you can 
work only with the main headings in the document. “Expand all” 
returns them to the list. Clicking the small up arrow in the center 
above the first heading (shown) jumps you back to the beginning 
of the document. Think how useful this could be for editing a 50+ 
page document. 
 

 
 
The Pages  tab displays numbered thumbnails of all the pages in 
the document, a handy way to move around a document or check 
page layout in a document with graphics. Selecting one of the 
thumbnails opens it in the document window. Scrolling through 
the thumbnails to find a page near the end of a long document is 
much quicker than scrolling through each page. But if you do 
scroll through the document, the Pages tab will highlight the 
thumbnail of the page you are viewing.  
 
This aspect of the Navigation Pane has been part of the 
PowerPoint program through several versions. In Office 2013, it is 
found not only in Word and PowerPoint, but also in Publisher and 
Outlook.  
 

Figure 3  Styles Gallery in Word 

Figure 4  Headings tab and menu 

Figure 5  Pages tab 
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The Results  tab serves several important functions. The 
Search box at the top lets you find almost anything you 
can put in a document. When you type a word or phrase 
in the Search box, all instances of the word will be listed 
with their surrounding text, as shown in Figure 6, and also 
will be highlighted in the document.  
 
 
 
 
 
 
 

 
 
To search for photos, drawings, tables, objects, equations, and footnotes, click 
the magnifying glass inside the Search box (Figure 7) and make your choice.  
To move through the search results, use the up and down arrows to the right of 
the Results number (hidden behind the menu in Figure 6). 
 
 
 
The Find and Replace feature, found on the Home tab in many versions of Word, has also been 
conveniently included among the Navigation Pane options. To use it, click the small down arrow next to 
the magnifying glass in the Search box (Figure 7). Click Options to refine your word search; click 
Advanced Find to open the Find and Replace dialog box.  As you use the Word Navigation pane, you will 
find it houses a wealth of helpful tools.  
 

Figure 6  Results tab and menu 

Figure 7 Search tool for objects 


